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Introduction 

Plateau Report Designer extends the BIRT Report Designer. The BIRT 
Report Designer is an open source application built in the Eclipse 
framework. This document describes some basic concepts of the Plateau 
Report Designer, the underlying BIRT Report Designer, and the BIRT 
reporting engine. 

Audience for This Document 

This document is written for report designers and for those who have been 
through SuccessFactors training for Plateau Report Designer. 

This document is not a substitute for Plateau Report Designer training. We 
expect that readers have been to training and are using this document to 
refresh their memories after training. 

Software Referenced by This Document 

Report designer users should also be familiar with the following software and 
standards: 

 SuccessFactors Learning 

 JavaScript 

 SQL 

 DBMS clients like SQL Developer™ or SQL Navigator™ 

Books About BIRT Report Designer 

You can combine the content of these books with this document to gain a 
fuller understanding of Plateau Report Designer. The books contain 
information about BIRT Report Designer and the BIRT framework, both of 
which are the foundation of reporting. This document describes the ways 
that we have extended BIRT offerings to create Plateau Report Designer.  

 BIRT 2.6 Data Analysis and Reporting by John Ward and others, ISBN 
978-849511-66-7. This book is an excellent introduction of the most 
commonly used features of report designer. 

 BIRT: A Field Guide to Reporting (2nd ed) by Diana Peh, Nola Hague, 
and Jane Tatchell. ISBN 978-0321580-27-6. This book is the complete 
reference guide. It includes advanced content. 
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Basic Orientation 

Files you use in Plateau Report Designer 

Plateau Report Designer creates reports for use in SuccessFactors Learning. 
Each report is composed of required and supporting files. Required files 
must be present in the report package you import into SuccessFactors 
Learning whereas supporting files are optional, but recommended. 

Required Files 

SuccessFactors Learning Reports must have the following two files. Because 
they are required, SuccessFactors Learning bundles them together in a report 
package. 

 .rptlibrary—.rptlibrary files are report library files. They contain shared 
resources such as styles, data sources, and images. SuccessFactors 
Learning contains three libraries: 

 PlateauThemes.rptlibrary contains the images (like logos) and 
style sheets (themes) that control the look of reports. 

 PerformanceThemes.rptlibrary contains the images and style 
sheets (themes) that control the look of performance reports. 

 Plateau.rptlibrary contains everything else, like report parameters. 
In general we recommend that you do not change 
Plateau.rptlibrary. 

 Performance.rptlibrary is a specific library that applies to the 
Printed Performance Review Template only. Unless you are 
changing the printed performance review, you can ignore it. 

 TalentPoolsUserLibrary.rptlibrary is a specific library that applies 
to the printed reports for Talent Pools. 

 .rptdesign—.rptdesign files are report design files. They contain information 
unique to the report and links to shared resources in the library. 

When you pass reports between SuccessFactors Learning and Plateau Report 
Designer, you pass a .zip file package that contains an optional .properties 
file. 

Supporting Files 

SuccessFactors Learning reports often use the following supporting files. 
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 .properties—Reports often use one .properties file per report for I18N 
labels. Any report delivered by SuccessFactors Learning, for example, is 
internationalized and so uses a .properties file. 

 Review.xml—Review.xml is used by one .rptdesign file in SuccessFactors 
Learning, the printed Performance Review Template. 

Supporting files are not necessarily part of the report package. You obtain 
them in other ways, such as the label import/export wizard for .properties 
files. 

The Graphical User Interface (GUI) 

The Plateau Report Designer GUI extends the BIRT Report Designer GUI. 
It contains three panes, which you can rearrange and configure. 

1. The resources pane contains the objects that your report uses, including 
data resources, styles, structure, images, and libraries. 

2. The layout pane contains the layout of the report, including the grid, the 
data tables, and the placement of your resources in the report. 

3. The properties pane contains the properties of objects that you select 
either in the resources pane or in the layout pane. 

The image below shows the default layout of Plateau Report Designer. The 
numbers in the image correspond to the numbers in the list above. 
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The Resources Pane 

The resources pane contains the objects that are available to the report. 
Although you can use anything in the resources pane in your report, most 
reports limit the usage to: 

 Data Sources—Data sources define the database or databases that the 
report will query to populate the layout. Although data sources can be 
many different things (from .xml files and flat files to data warehouses) 
most reports run against the SuccessFactors Learning transactional 
database tables. 

Because Plateau Report Designer was created for SuccessFactors Learning 
custom reporting, the SuccessFactors Learning database is the only 
supported database data source. 

 Data Sets—Data sets are chunks of data selected from a data source. 
Most reports have a 1:1 relationship between data sets in the resources 
pane and tables in the layout pane. 

 Report Parameters—Report parameters are user input into a report 
before it runs. Most parameters are linked from the library and are a 
search selector in SuccessFactors Learning. 
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 Styles—Styles define the look of content in the layout pane much like 
CSS. 

 Libraries—Every report needs at least one library, which contains shared 
resources. 

See the BIRT help for specific information and usage of tabs like the Data 
Explorer, Outline, Palette, and Resource Explorer. 

The Layout Pane 

The elements in the layout pane correspond to the Body node in the Outline 
tab of the Resource pane. If you remember that .rptdesign files are XML 
files, then you can see the Body node and its children as the DOM structure 
of all the elements inside the Body node of the .rptdesign file. 

The layout pane is where you design your report in a WYSIWYG interface. 
The main elements of the layout pane are: 

 Grids—In most reports, grids are containers for tables. They control the 
position of the tables on the report. 

 Tables—Tables are containers for data. Most reports have a 1:1 
relationship between tables and data sets and tables are bound to the data 
set. You can read more about binding in the help. 

 Cell Contents—Cell contents are things that can go inside the cells of 
tables and grids, such as labels, data, text, or charts. Cell contents can also 
include nested grids and tables. 

The bottom of the layout pane has five tabs. Most of your work can be done 
in the Layout tab, but you might also find the following tabs useful: 

 Master Page—A master page is a starting point for the report. The 
delivered reports have a simple master page. 

 Script—Advanced report writers can include scripts to manipulate 
reports in the BIRT report engine. Read the scripting help in the BIRT 
community for more information. 

 XML Source—The XML Source tab contains a view of the underlying 
XML of the .rptdesign file. Although you should not edit the file directly, 
you might find some benefit in reading it to understand the report, 
especially if you are a more technical user. 

 Preview—The Preview tab tests the report. 

The Properties Pane 

The Properties pane contains the properties of the element you select in the 
Layout or Resources pane. It changes based on your selection, so if you 
select a table, you see the properties allowed for a table. If you select a data 
element, you see the properties available for the data element. 
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GUI Tips 

When working in Plateau Report Designer, keep the following tips in mind 
for the interface. 

Linked to Library Symbol 

The Linked to Library symbol signifies that its object is linked to the library. 

For example, a linked to library Report Parameter  symbol signifies that 
the parameter is linked to the library. 

When an object is linked to the library, you cannot edit it in the report 
design. If you want to edit it, you must do so in the library. When you change 
it in the library, you update all reports using the library. 

Context Sensitivity of Interface 

The user interface of Plateau Report Designer changes based on what you 
select. For example, when you select a table, the Properties pane changes to 
show only the properties available to a table. 

Additionally, some buttons are available or unavailable based on your 
selection. For example, you cannot create a report .zip package with the Save 

Report .zip  button unless you select the .rptdesign file at the top of the 
Outline tab in the Resources pane. 

Create/Unpack Report Package 

Opening and saving an .rptdesign or .rptlibrary file is different from creating 
or opening a report .zip file. 

 You save a report or a library by using the File menu when you want to 
save your changes locally. 

 You open a report or a library by using the File menu when it is saved 
locally. 

 You open a report .zip by using the Actions menu when you have 
exported a report package (a .zip file) from SuccessFactors Learning, 
downloaded it to your local drives, and you want to open it in Plateau 
Report Designer. 

 You save a report .zip by using the Actions menu when you are ready to 
import it into SuccessFactors Learning. Plateau Report Designer creates 
the report package for you to import. 

Preview Report 

When working on a report, you can and should test it often. You can test it 
in two ways: 

 Click the View Report button in the toolbar. 

 Click the Preview tab in the layout pane. 
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Linking the .properties File to See Labels 

All reports are internationalized. They use labels instead of clear text so that 
the reports work in multiple languages. If you do not link to the labels, then 
you see strange behavior in labels within the layout tab. 

To link labels, first export your language’s labels from SuccessFactors 
Learning using the Label Import/Export Wizard (see SuccessFactors 
Learning help for information about exporting labels). Save the file as 
ApplicationResources.properties in the workspace. 

Put the files in the workspace, and then in the Properties pane for the 
Report, go to the Resources tab. Add the ApplicationResources.properties 
file in the Resource File box. 

Refresh 

Plateau Report Designer can require you to refresh the interface to pick up 
changes. Most commonly, you need to refresh: 

 Data bindings—You often need to refresh data binding, particularly 
when you change a data set. 

 Resource explorer—When you add a new resource to the workspace, you 
can refresh the resource explorer to bring new files into the Properties 
pane. 
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Fundamental Concepts 

Plateau Report Designer and BIRT 

BIRT has its own report design tool, the BIRT Plateau Report Designer, 
which was extended to create the Plateau Report Designer. 

Use only the Plateau Report Designer, not the BIRT Report Designer. 

Because Plateau Report Designer is an extension of the BIRT Report 
Designer: 

 You have access to the BIRT Report Designer community and 
documentation. We recommend BIRT: A Field Guide to Reporting, BIRT 
2.6 Data Analysis and Reporting, and the BIRT community website. 

 You see more features and functionality in Plateau Report Designer than 
we describe here. We recommend that you use the available BIRT Report 
Designer documentation and community to understand the additional 
features and functionality. 

Plateau Report Designer Extensions to BIRT Report Designer 

We extended the BIRT Report Designer in the following ways to create 
Plateau Report Designer. The extensions allow the report designer to work 
with SuccessFactors Learning. This section describes only the existence of 
the extension. For information about its use, see the help. 

The extensions built into Plateau Report Designer require: 

 That you use Plateau Report Designer, which is free to SuccessFactors 
Learning users, instead of BIRT Report Designer. 

 That you match your Plateau Report Designer version to your 
SuccessFactors Learning version (to the patch level). 

Opening and Saving Report Packages 

Use the Open Report Package and Save Report Package extensions to create 
and open report packages. 

A report package is a .zip file containing the files described in the Required 
Files section on page 2. 

If we improve the extension to do more than collecting and compressing 
files, you will already be in the habit of using the extension and you can be 
assured that the report package is created correctly. 

http://www.eclipse.org/birt/phoenix/birthelp.php
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Support for Operators 

Operators are function calls from the report to SuccessFactors Learning. 
They do things like localize values to the current user’s locale. You can read 
more about operators in the help and in the Reporting Framework SDK guide. 

Addition to Data Sets 

SuccessFactors Learning custom reporting has a data set framework that 
both SuccessFactors Learning and Plateau Report Designer understand. It 
includes: 

 Access to domain security. Domain security ensures that the values in the 
result set at run time include only values that the user has rights to. Read 
more in the Security section on page 9. 

 Access to search selectors. A search selector is a filter. The user search 
selector, for example, allows the report user to select a set of users to 
appear in the report. Read more in the Filtering Result Set section on 
page 10. 

 Access to SuccessFactors Learning result set ordering. SuccessFactors 
Learning ordering allows users to choose how results will be ordered at 
run time. Read more in the Sorting/Ordering Result Sets section on page 
11. 

Security 

Report security controls two aspects of reporting: 

 The reports that a user can access to run: security can allow a given set of 
users access to run a given set of reports and likewise deny a set of users 
access. 

 The records in the result set of a report: security can ensure that reports 
return only records that the report runner has access to. 

Security works differently in SuccessFactors Learning Administration and the 
SuccessFactors Learning end user environment. 

SuccessFactors Learning Administration Security 

In SuccessFactors Learning Administration, security is controlled by 
domains, workflows, and roles. 

 A domain is an attribute assigned to major entities in SuccessFactors 
Learning. Some minor entities, such as Employee Status, do not have a 
domain attribute because they are meant to be associated with a major 
entity. 

 A workflow is a task in SuccessFactors Learning Administration, like 
“Edit Report Details” or “Update User.” 

 A role is a set of users who are restricted to a set of domains (entities) 
and workflows (tasks). A user in the Manufacturing Learning 
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Coordinator role, for example, might have access to Manufacturing 
domains and Learning Coordinator workflows. 

SuccessFactors Learning End User Security 

In the SuccessFactors Learning end user environment, security is controlled 
by search contexts. Search contexts are a black box. As a report designer, you 
only need to know that your audience has a matching search context. 

Search contexts determine, based on the position of the end user and the 
configuration of SuccessFactors Learning, what any search can return. For 
example, organization owners of parent organizations with “line of site” 
configuration can see different organizations than their child organization 
owners. 

User Input on Result Sets 

SuccessFactors Learning custom reports, as built by Plateau Report Designer, 
concern transactional data. Report users call the report to return specific 
transactional data in a specific way. The users want to: 

 Filter the data: they want to return only a select set of all the transactional 
data in the SuccessFactors Learning database. For example, they might 
want to see a report of users in a specific organization. 

 Order the data: they want to order the result set in a specific way, such as 
alphabetically. 

 Group the data: they want to group the result set in a specific way, such 
as instructors grouped by the learning items they are authorized to teach. 

Plateau Report Designer is built with tools to support a particular strategy for 
the tasks above. 

Filtering Result Sets 

After you decide what results the report itself will return (users in a scheduled 
offering, overdue assessments in a performance review, and so on), you 
should allow the report user to filter the result set from all users or all 
assessments to only the assessments he or she is interested in. You do this by 
building parameters to link to search selectors or to stand on their own. 

Custom reporting has access to SuccessFactors Learning search selectors. 
SuccessFactors Learning installs with most of the search selectors you need. 

At run time, the search selector appears with a Filter  button. The 
following example shows the User search selector (includes the Filter 
button). In contrast, the User Status list is a standard report parameter (it 
does not include the Filter button). 

The following example shows two kinds of result set filtering at run time. 
The first, User is a search selector because it has a Filter button. The second, 
User Status is a Plateau Report Designer parameter because it does not have a 
Filter button. 
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Users click the Filter button in the User field to open the filter of the search 
selector. There, they can submit a filter by selecting user attributes. Note that 
the User search selector also contains a User Status field, which the report 
runner can use to filter his or her result set. The User Status Plateau Report 
Designer parameter is on the first page for convenience. 

 

Users submit, for example, a filter that returns all users in a given role who 
are not active. The report runs and returns a result set of only those users. 

Sorting/Ordering Result Sets 

For the purposes of this document, we call the ordering of result sets ordering 
and not sorting. This is to align more closely with the accepted Plateau Report 
Designer and SQL syntax. 

To help report users understand a report’s results, you should consider how 
the report user might want the results ordered. Plateau Report Designer uses 
parameters for ordering purposes. The report user can select a choice for 
ordering from a parameter at run time. SuccessFactors Learning passes that 
choice to the report. 
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In the following example, you see the run-time results of order (called sorting 
in this case, for ease of use for the user). The user can order by Competency, 
Trend, or Current Rating. 

 

In Plateau Report Designer at design time, you match the ordering parameter 
with the ORDER BY statement in the SQL of a data set. Plateau Report 
Designer handles ordering in the SQL statement for greater performance. It 
passes the ordering on to the DBMS, which can handle it more efficiently 
than the application server. If you need to understand the details of ordering, 
see the Sorting/Ordering Result Sets section on page 21. 

Grouping Result Sets 

To help report users understand a report’s results, you should consider how 
the report user might want the results grouped. SuccessFactors Learning uses 
report groups to handle reports that return the same results, grouped 
differently. 

Each report group is a category of reports. The reports in a group run and 
return the same data, but grouped differently. You can add new report 
groups in SuccessFactors Learning in System Admin>References>Report 
Groups. The report user sees the following, which is the Curriculum Status 
report group, which returns the User Curriculum Status report grouped in 
five different ways. 

 

Each of the five is a different .rptdesign file. Each .rptdesign file has its 
grouping set in the Layout pane of Plateau Report Designer. 

We experimented with other methods to handle dynamic grouping in a single 
.rptdesign file, such as using the Plateau Report Designer scripting engine to 
switch layouts dynamically. The dynamic approaches proved overly complex 
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and difficult to maintain. The simpler approach was to create the report 
groups. If you need to understand the details of grouping, see the Grouping 
Result Sets section on page 23. 

Data Localization 

Starting in Learning 6.2.0, we localized some fields. Localized fields allow 
data, like an item title, to appear to users in their native language. 
Administrators create one item and translate the item’s title into many. Users 
searching for items in French, for example, retrieve the item title in French 
and English speakers return the title of the exact same item in English.  

To make data localization work, the system stores a label ID instead of plain 
text. For example, if you ran a SQL query and retrieved item titles, you see an 
ID: title.Item.0b657a134574bed6bdbb7d8e6dfd7fff. Learning cross 
references the user’s locale with the ID to return the localized label value. 

Using Report Context to Return Localized Values 

When you run a report from Learning, you have access to the report context. 
The report context has a method called getMessage. Given the data set row 
and the user’s locale, it returns the correct text: 

reportContext.getMessage(dataSetRow["your ds row"], 

reportContext.getLocale()) 

The method requires the data set row to get the ID and the user’s locale. In 
almost all cases, you pass it the column binding name to get the ID. For 
example, when you return “CPNT_TITLE:” 

dataSetRow["CPNT_TITLE"] 

In almost all cases, you request the locale from the report context to get the 
current user’s locale: 

reportContext.getLocale()) 

To see a working example of the report context method, export and open 
the user learning plan report. The CPNT_TITLE cell in the learning plan is 
localized. 

Manually Joining Tables to Return Localized Values 

If you cannot use the report context, then you must manually join tables to 
return the correct localized values. For example, if you plan to run your 
reports from within Plateau Report Designer and not in Learning, then you 
must join the tables because the report context is only available on the server 
and not on the PRD client. 

The query below demonstrates the join of the item title (CPNT_TITLE) 
with the label ID (LABEL_ID) in the English locale: 

Select a.cpnt_id, b.label_value1, a.cpnt_title, 

b.label_id 
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    from pa_cpnt a, pa_i18n_active_locale_label b 

    where b.locale_id='English' 

    and a.cpnt_title=b.label_id 

The results of the query return data like the following. You see that 
CPNT_TITLE and LABEL_ID are the same and that the 
LABEL_VALUE1 appears in English. You use the LABEL_VALUE1 in 
your report. 

CPNT_ID LABEL_VALUE1 CPNT_TITLE LABEL_ID 

COMM0161  Difficult People in the 
Workplace  

title.Item.b10cd556c5f8e79f
28f54c8956a71659  

title.Item.b10cd556c5f8e79f
28f54c8956a71659 

SALE0132  Understanding Your Customer  title.Item.d548cd4b60a0cad
5d6e2832734efb892  

title.Item.d548cd4b60a0cad
5d6e2832734efb892 

CONS0125  Evaluating Internal 
Assignments 

title.Item.d94979443e8a0c9
0014ed894e055a750  

title.Item.d94979443e8a0c9
0014ed894e055a750 

PROJ0001  Project Initiation title.Item.21d10dbf9bfac7dc
d64337f4f7a39229  

title.Item.21d10dbf9bfac7dc
d64337f4f7a39229 

MGMT0256  e-Mentoring  title.Item.f5df8fdda5afea74b
e026207576b7449  

title.Item.f5df8fdda5afea74b
e026207576b7449 
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Common Tasks 

After you understand the concepts as described in the Fundamental 
Concepts section on page 8, you need to understand how to implement those 
concepts in reports. 

Selecting Data in a Data Set 

In most cases, you can match each data set to a table. For example, if you 
want to include a table of user information (first name, last name, employee 
status, and supervisor), you should create a data set called user information. 

Think of data sets as functions that retrieve data for use in the report. As 
such, each data set contains: 

 One data source, which is the place from which the data set retrieves its 
data. 

 A data retrieval method, which is how the data set retrieves its data from 
the source. In almost all SuccessFactors Learning reports, you retrieve 
data using a SQL SELECT statement. 

 Input parameters, which are passed into the data set before it executes its 
data retrieval. Input parameters can come from users or other parts of 
the report, such as other data sets. The data set uses the parameters to 
filter the data it returns. Input parameters go into the WHERE clause. A 
statement like: SELECT [user information] ...WHERE supervisor = ‘jdoe’ has 
one parameter, supervisor, which in the example is set to jdoe. 

 Output parameters, which are passed out of the data set after it runs for 
use in a report or another data set. Output parameters are declared in the 
SELECT clause of the SQL statement. A statement like SELECT fname, 
lname ... WHERE supervisor = ‘jdoe’ outputs the first name and the last 
name of the users whose supervisor is jdoe. 

SQL Syntax for Data Sets 

In the majority of cases, reports written for SuccessFactors Learning use 
SQL in data sets. We have added a framework to the SQL syntax in data sets. 
The framework allows Plateau Report Designer and SuccessFactors Learning 
to communicate on domain filtering, ordering, and search selectors. 
Additionally, the BIRT framework has syntactic conventions that it follows 
to add BIRT input parameters. 
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Bracket Syntax 

Data sets you create are SQL SELECT statements written against the 
SuccessFactors Learning transactional data. As such, you must have a solid 
understanding of SQL syntax. 

SuccessFactors Learning custom reporting, however, adds syntax that it can 
interpret after you import the report. The additional syntax is contained in 
brackets, and therefore called bracket syntax. 

If you download a delivered report and look at its data set, syntax outside the 
brackets is standard SQL syntax. Syntax inside the brackets is SuccessFactors 
Learning syntax. The following are examples of bracketed syntax: 

[UserSearch] 

[security:PA_STUDENT] 

[order_by_parameter OrderBy 

“FNAME=a.fname;LNAME=a.lname”] 

[sub-select:ApprovedState "status_val=1"] 

The syntax is interpreted by the SuccessFactors Learning server and, 
therefore, works after you import the report to SuccessFactors Learning. 

SuccessFactors Learning Comments in SQL 

Bracket syntax does not work when you test the data set from within Plateau 
Report Designer because SuccessFactors Learning is the interpreter. 
However, you test data sets in Plateau Report Designer, so you need a way to 
hide the syntax temporarily, while in Plateau Report Designer and show the 
syntax after you import to SuccessFactors Learning. 

Plateau Report Designer solves the problem with special comment 
characters. The comments resemble Java multi-line comment syntax, but 
have an additional asterisk at the beginning of the comment marker. While 
you are working in Plateau Report Designer, the comments hide the hooks 
from Plateau Report Designer. When you import, SuccessFactors Learning 
strips the special comments from the SQL code. 

For example: 

SELECT a.fname, a.lname 

FROM pa_student a 

WHERE 1=1 

/** AND a.stud_id in [UserSearch] 

AND [security:pa_student a] 

*/ 

In the example: 

 The bracketed syntax: [UserSearch] and [security:pa_student a] are the 
hooks to the User search selector and the domain security respectively. 
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 You test the security on the PA_STUDENT table and the UserSearch 
filter after you import to SuccessFactors Learning. 

 The opening comment syntax (/**) contains two asterisks instead of the 
usual one for Java comment syntax. It must have two so that the import 
wizard in SuccessFactors Learning can recognize the comment and strip 
the characters on import. 

 The convention of adding WHERE 1=1 is for your ease of design. It 
ensures that you have a WHERE clause so that you know everything in 
the comments can use the AND conjunction. 

After you import the report to SuccessFactors Learning, the SQL in the 
report is recognized as: 

SELECT a.fname, a.lname 

FROM pa_student a 

WHERE 1=1 

AND a.stud_id in [UserSearch] 

AND [security:pa_student a] 

Result Set Filtering 

This section assumes you understand the concept of result set filtering as 
described in the User Input on Result Sets section on page 10. 

To access a search selector, you add the matching parameter from the 
Plateau.rptlibrary, and then you write the parameter into the WHERE clause 
of the SQL statement. The following is an example from the delivered report 
UserPlanStatusBySup.rptdesign. 

1. Add the UserSearch parameter from the Plateau.rptlibrary to the report. 

2. Add the UserSearch parameter to the SQL statement in the data source. 

 The parameter must go into in the comment notation as 
described in the SuccessFactors Learning Comments in SQL 
section on page 16. 

 The parameter must go in brackets [] and must be typed exactly 
as it is in the library. 

 The parameter must not contain white space. 
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The result, at run time, is the User Search Selector (filter). The user sees the 
User fields, as below: 

 

You can also create your own parameters and call them in the SQL 
statement. The example, UserPlanStatusBySup.rptdesign, includes such a 
parameter, ActiveFilter. 

1. Create a parameter in the Report Parameters folder of the report. For 
example, you can create an ActiveFilter parameter to appear like the User 
Status list (below) at run time. It is a Plateau Report Designer parameter 
that is a list of values: active, not active, and both. 

 
2. Configure the parameter to fit your situation. Plateau Report Designer 

only needs the Name to be exact and have no white space. 
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3. Add the ActiveFilter parameter to the SQL statement in the data source. 

 The parameter must go into in the comment notation as 
described in the SuccessFactors Learning Comments in SQL 
section on page 16. 

 The parameter must go in brackets [] and must be typed exactly 
as it is in the library. 

 The parameter must not contain white space. 
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Domain Security 

This section assumes that you understand the concept of SuccessFactors 
Learning security as described in the SuccessFactors Learning Administration 
Security section on page 9. It describes how you use Plateau Report Designer 
SQL syntax to enforce domain security in the result set. 

To use SQL syntax to enforce domain security on reports’ result sets, first 
choose the table/entity that closely matches your SELECT statement. It can 
be any table that includes a DMN_ID (Domain ID) column. For example, if 
you write a report to return users, use the user record (pa_student table). If 
you write a report to return learning items, use the learning item record 
(pa_cpnt). If you write a report to return the users enrolled in a given 
learning item, think about how you want to restrict the report: by the report 
runner’s access to users or the report runner’s access to learning items. 

After you select a record to enforce domain security, you insert the following 
syntax into the WHERE clause, inside the comments (as described in the 
SuccessFactors Learning Comments in SQL section on page 16). The syntax 
is interpreted at runtime by SuccessFactors Learning to generate a more 
complex query for domain filtering. The object of WHERE clause takes the 
syntax: 

[security:the domain restricted entity] 

For example, if you use the pa_student entity for domain restriction, type: 

[security:pa_student] 

The syntax [security:pa_student] filters all records in the result set where the 
report runner is denied access to users (students) because of the domain 
associated with the user record. If the report runner is in the manufacturing 
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domain and is restricted from seeing users in the sales domain, the report 
returns no users from the sales domain. 

The following SQL query selects the user ID, first name, and last name from 
the pa_student table. 

Use the Special comment characters in the where clause to prevent the where 
clause from executing while you design the SQL statement. 

SELECT a.stud_id, a.lname, a.fname 

FROM pa_student a 

WHERE a.active = ? 

/** AND a.stud_id in [UserSearch] 

    AND [security:pa_student a] 

      ORDER BY [order_by_parameter OrderBy 

"FNAME=a.fname;LNAME=a.lname"] 

*/ 

If the data in the table is as follows: 

STUD_ID Active LNAME FNAME DMN_ID 

GW Y Washington George Manufacturing 

TJ Y Jefferson Thomas PUBLIC 

AL Y Lincoln Abe Sales 

TR N Roosevelt Theodore Manufacturing 

RR Y Reagan Ronald Administration 

 

The WHERE clause returns the following students under report runners 
with access to domains. PUBLIC is a special domain that allows public 
access. 

Report runner with access to... Can return these users... 

Manufacturing George Washington, Thomas Jefferson, Theodore 
Roosevelt 

PUBLIC Thomas Jefferson 

Sales & Administration Thomas Jefferson, Abe Lincoln, Ronald Reagan 

Sorting/Ordering Result Sets 

This section assumes that you understand the concept of ordering as 
described in the Sorting/Ordering Result Sets section on page 11. 
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Create Parameter for Ordering 

In Plateau Report Designer, you create a parameter to contain the values that 
users can order by. In the following example you see a parameter that 
contains two values: first name and last name. At run time, this allows users 
to order their reports by users’ first names or users’ last names. 

 

Notice that the name of the parameter is OrderBy. The values that the user 
can select from the OrderBy parameter are FNAME (representing the first 
name of the users) and LNAME (representing the last name of the users). 

Refer to the Parameter in the SQL Statement 

After you create the parameter to contain the users’ selections for ordering, 
you need to refer to the parameter in the SQL statement. We recommend 
that you control ordering in the SQL statement for performance reasons. 
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The DBMS is uniquely suited for tasks like ordering data and will perform it 
better and faster than the application server. 

In the report query, include the text: 

[order_by_parameter:BIRT Parameter 

"SelectionValue1=Column1;SelectionValue2=Column2"] 

Replace: 

 "SelectionValue1" and "SelectionValue2" with the selection values as you 
defined them in your parameter. 

 "BIRT Parameter" with the parameter you created for user input at run 
time. "Column1" and "Column2" for the columns in your SELECT 
statement that match the parameter selection values. 

Use comment characters. To use the parameter above, the statement 
resembles the following: 

SELECT a.stud_id, a.lname, a.fname 

FROM pa_student a 

WHERE a.active = ? 

/** AND a.stud_id in [UserSearch] 

    AND [security:pa_student a] 

      ORDER BY [order_by_parameter OrderBy 

"FNAME=a.fname;LNAME=a.lname"] 

*/ 

Remember to include the comment characters as described in the 
SuccessFactors Learning Comments in SQL section on page 16. 

Grouping Result Sets 

This section assumes that you understand the concept of grouping as 
described in the Grouping Result Sets section on page 12. 

To group result sets, you create more than one layout, which requires more 
than one report (.rptdesign file). You categorize the reports in report groups, 
which you create in SuccessFactors Learning. 

1. Create one report for each way that you want to group the result set. For 
example, these two examples group by supervisor and by status. The 
tables in the grid are arranged differently to create the groups. 
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Grouped by Status: 

 

Grouped by Supervisor: 

 

2. Create a report group to contain the multiple reports. Choose a name 
that summarizes the reports in the group. For example, if the reports 
return user learning plans and their status, you can call the group User 
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Learning Plan Status. You create report groups in SuccessFactors Learning. 
Go to System Admin>References>Report Groups. 

3. Save the report .zip files and import them as usual to SuccessFactors 
Learning. In the Report Details dialog box, select the report group you 
created. 

 

4. Save and close the Report Details dialog box. 

Creating a CSV Output Report 

For examples of CSV reports, you can look at any of the CSV .rptdesign files 
delivered in SP5 P15. For example, you can look at 
UserItemStatusCSV.rptdesign. 

When you want users to be able to output a report to a .csv file you create a 
new .rptdesign file and add it to the report group where the other formats are 
stored. For example, the UserItemStatusCSV.rptdesign is in the Item Status 
report group. Users can run other Item Status reports in that group and 
output them as HTML or PDF. You add the CSV .rptdesign file so that they 
can output the report as a .csv file. 

You can think of the CSV file as another grouping of the data. For example, 
Item Status reports have a Group by Items report and a Group by Users 
report. The UserItemStatusCSV.rptdesign file is a “no grouping” report 
because .csv files, by definition, have no grouping. A flat file of comma 
separated values cannot be grouped. 

1. Click File>New>Report.  
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2. In the File Name box, type a name for your report design file. Click 
Next. 

3. In the Report Templates box, select Blank Report. Click Finish. 
Plateau Report Designer creates your report. 

4. In the Outline tab, right-click Libraries, select Plateau.rptlibrary, and 
then click OK.  

5. Drag the ReportDestinationCSV and ReportFormatCSV from the 
Resource Explorer tab>Plateau.rptlibrary>Report Parameters 
folder and into the Outline tab>[your report]>Report Parameters 
folder. The two variables must always be in the first and second position, 
no matter what other parameters you add. 

 

 

6. Create the rest of the report as if it were any other report, except for the 
following: 

 Because CSV reports are a flat file, you cannot use any grouping. 

 Because CSV reports are a text file, you cannot include a logo, 
colors, or any other styles to the report. 

7. Import the report to SuccessFactors Learning, selecting the appropriate 
report group, as described at the beginning of this section. 
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Development Strategy 

This section describes how you should go about creating custom reports, 
including hints and shortcuts. 

Testing Reports 

We recommend that you use the following testing strategies throughout the 
report development process. 

Test Early and Often 

When you develop a report, you often work with complex data sets, layouts, 
and functions. We recommend that you test your report constantly, at every 
stage of development. Plateau Report Designer was built with testing in 
mind. The comment syntax, as described in the SuccessFactors Learning 
Comments in SQL section on page 16. 

For example, when you create a new data source, click the Test Connection 
button to test the set up. When you create a new data set, test it in Preview 
Results. Unit testing each object ensures that the object is built properly 
before you move on to other objects that use it. 

Create Realistic Test Cases 

Create test cases that match realistic scenarios Common test cases include: 

 Null values: Users’ e-mail addresses are not required. If you have a report 
that returns e-mail addresses, test the report using records with null 
values for e-mail addresses. 

 Tolerance for conditional elements: If you plan to change the warning 
text on your report depending on the length of time an item is overdue, 
be sure to test it under data that covers all cases of overdue items and the 
length of time they are overdue. 

 Time zones: Create users in different time zones and test the report in 
different time zones. 

 Security: Create report runners with access to different domains to ensure 
that the report returns only the results in the users’ domain filtering. 

Promote and Test 

Before you go live, test and promote the report as you would test and 
promote any customization. Custom reporting includes utilities to help you 
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with promoting and testing reports. Generally speaking, test in the following 
ways: 

1. Test the report in Plateau Report Designer. When you test in Plateau 
Report Designer: 

 You likely test against staging data, so the data source changes 
when you import to a test or production environment. 

 You cannot test security, ordering, parameters, or any bracketed 
syntax in Plateau Report Designer. Those functions only work 
after you import to SuccessFactors Learning. 

 You might need to insert some report elements specifically for 
testing. For example, if you create a report that returns scheduled 
offerings, you might hard code some scheduled offering IDs in 
the WHERE clause of the data set to return only scheduled 
offerings that match your test cases. 

2. Import the report to a SuccessFactors Learning development/test 
environment. When you import to a development/test environment: 

 Remove any elements you added specifically for testing within 
Plateau Report Designer. For example, if you added a WHERE 
clause for testing, comment it out. You can comment it out by 
using standard SQL comments: two dashes (--). 

 Test any bracketed syntax, such as security, ordering, or 
parameters after you import. 

 Test any localization, including labels, time zones, and data 
patterns after you import. 

3. Import the report to production. When you import to a production 
environment: 

 Switch the data sources to the production data source. 

 Remove/comment out testing elements. 

 Import the report as unpublished. When a report is in the 
unpublished state, common users cannot see it. Testers, however, 
can see the report and test it against production data. After you 
have tested the report in the unpublished state, and it has passed 
your test cases, publish it. 

Planning Reports 

When you plan reports, you either start with an existing report and modify it 
to suit your needs or you build a report from scratch. 

 If you start with an existing report, print it out and mark up the report. 

 If you start from scratch, sketching out the to-be report. 

Consider the following elements of the report layout. 
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Colors, Images, and Fonts 

Consider the colors for the report, the images (such as logos) to appear in the 
report, and the font set to use. 

 If you want to affect all reports in the system, you can change the styles 
in the PlateauThemes.rptlibrary library file. 

 If you want to change only specific reports’ styles, add a new library with 
the styles you need and associate the library with the reports. 

 If you want to use an image in a report, embed it in an associated library. 
Doing so opens the possibility that you could use it in more than one 
report. 

Data Representation 

Consider how you want the data in the report to be represented. For 
example, how do you want dates to be formatted? Do you want the text to 
change color if the data reaches some kind of limit? Do you want user IDs to 
be masked. 

Plateau Report Designer has the following tools to help you change the way 
data is represented: 

 Data typing: You can change the way that a data element displays by 
changing its data type. For example, data sets commonly return datetime 
but report users want just the date. If you change the data element to the 
date data type, then the report users see only the date. 

 Expression Building: You can use the expression builder in Plateau 
Report Designer to concatenate values, change the format of values (for 
example from mm/dd/yyyy to m/d/yy), or to perform arithmetic on 
values. 

 Conditionality: You can use the expression builder to build conditionality 
into data. For example, if an item on a user’s learning plan is overdue, 
you can display the text overdue in a column. You use the expression 
builder and dynamic text to build the rule. The expression builder uses 
JavaScript syntax (it is a Rhino engine). 

 Operators: You can use operators, which are an advanced concept, to 
access data stored in the users’ session. For example, if you want to 
display a date in the current user’s time zone, you need to call an operator 
to get his or her time zone from the session and make the conversion. 
Operators are discussed in detail in the Reporting SDK document. 

Result Set Filters 

Most filtering can be done using search selectors, without building additional 
parameters. For example, the User search selector includes the Active check 
box so that report runners can select all active users. This means that you do 
not need to build an additional parameter for Active. 
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Security 

When you consider security for administrator reports, choose a table/entity 
for the security look up that closely matches what you want to select from 
the transactional tables. For example, if you write a report to return users, use 
the user entity (pa_student table). If you write a report to return learning 
items, use the learning item entity (pa_cpnt). If you write a report to return 
the users enrolled in a given learning item, think about how you want to 
restrict the report. 

Additionally, consider the users who should be able to run reports. Each 
report has its own workflow when you import it. You assign the permissions 
to edit the report or run the report to users’ roles. 

Ordering and Grouping 

Consider how you want to order the results in the report and how you want 
to group the results. If you want more than one grouping, you need to 
develop more than one report and place the reports in the same report 
group, as described in the Grouping Result Sets section on page 12. To order 
data within a report, read the Sorting/Ordering Result Sets section on page 
11. 

Research and Retrieve Data 

After you decide on the appearance of the report and the format of the data, 
you research the SuccessFactors Learning transactional to find the data you 
want to query. We recommend that you conduct your research in a database 
navigational tool such as SQL Navigator or SQL Developer. 

Researching the SuccessFactors Learning Database 

The following points are helpful to keep in mind when you research the 
database for data. 

By convention, tables in the SuccessFactors Learning database begin with a 
two letter code. The code PA represents the transactional tables, which are 
the ones you want to report against. 

Not all entity data is stored in one table, but these tables provide a starting 
point for research: 

 PA_STUDENT: Contains user entity data 

 PA_SCHED: Contains scheduled offering entity data 

 PA_CPNT: Contains learning item entity data 

 PA_REVIEW_PROCESS: Contains performance review entity data 

 PA_ASSESSMENT_PROCESS: Contains competency assessment 
process entity data. 
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Writing SQL to Retrieve the Data 

After you find the data in the database, you write SQL to retrieve the data. 
We recommend that you test your SQL in a database tool like SQL 
Navigator™ or SQL Developer™. As you write your SQL, keep the 
following in mind. 

You do not need to retrieve every piece of data in a single SQL statement 
because reports can have more than one data source and the data sources can 
pass parameters among them. For example, if you write a report to retrieve 
users’ information and based on the user, supervisor’s information, you can 
write a User data set and a Supervisor data set and pass the key (in this case 
supervisor ID) to the Supervisor data set. 

When you write your SQL statement at this stage, do not concern yourself 
with security, ordering, or filtering. You will add those later, in the data set. 

Use the SQL checking tools included in the SQL software you choose. After 
you have written the SQL to retrieve the data, copy it into the data set in 
Plateau Report Designer. 

Map Data Sets onto Layout 

After you create data sets, you can start to map them onto the layout tab to 
create the report. Keep the following in mind: 

 Use grids for layout and tables for data. For example, if your want to 
divide the report into cells for the purpose of placing images and text, 
use a grid. If you want to create tabular data, use a table. 

 Bind data sets to tables and refresh the binding when you make a change 
to the table or the data set. If you do not refresh, you can see odd 
behavior when you test the report. 

 If you must localize the report, associate the .properties file with the 
report at the beginning and see if labels already exist for the text to 
localize. If you are modifying an existing report, chances are that the 
labels already exist. 

Checklist for Importing Reports to SuccessFactors Learning 

Before you import a report to SuccessFactors Learning, prepare by looking at 
the following checklist: 

 Comment out any testing clauses in the data set. For example, if you 
tested your data set on one particular user, you might have hard-coded 
the user ID in the WHERE clause during development. 

 If necessary, switch the data source of the data sets. Report designers 
usually connect to staging data. If you are importing to a production 
instance of SuccessFactors Learning, you need to switch the data source 
to production data. 
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 If you added labels, import the new labels to SuccessFactors Learning 
using the Label Import/Export Wizard. 
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Example 

The following example starts with an existing report and modifies it 
according to the strategy outlined in the Development section on page 27. 

As-is Sign-in Sheet Report 

The as-is sign in sheet appears below. 

 

The report groups segments by the scheduled offering, and users by segment. 
Users sign in next to their name to prove they have attended the segment in 
the scheduled offering. 

To-be Sign-in Sheet Report 

The following is an overview the to-be report. 
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The to-be sign-in sheet requires the following changes: 

 New Images and new colors: The new report has a new logo and new 
colors in the header 

 Site sign-in at bottom of report 

 New Data: 

 Facility Description 

 Facility Phone Number 

 Email Address of User 

 Organization of User 

 Total Users (a sum of all user names) 

 Enrollment flag (conditional text: if enrollment is not met, show 
flag) 

 Removed Data: 

 Segment ID 

 User ID 

 Data Formatting change: The start time/date and end time/date are 
formatted without their time zones 

As recommended, it is helpful to mark up the report to understand the data 
you are adding, the formatting changes, and the data format changes. 
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Changing the Layout: Fonts, Colors, Images, and Text 

Decide if you want to update all reports with the new layout information or 
if you want to affect this report only. This example assumes that the redesign 
is part of a rebranding effort, so it makes changes to the PlateauThemes 
library.  

Adding the Logo to the Library 

You can add a logo in the library, which makes the image available to any 
report using the library. It is common for companies to change all logos in all 
reports. To understand the interaction between report files and library files, 
read the Files you use in Plateau Report Designer section on page 2. 
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1. Copy the logo to the workspace. 

2. Open Plateau Report Designer and then open the 
PlateauThemes.rptlibrary file. 

3. In the Outline tab, find the Embedded Images node. 

4. Right-click Embedded Images and then click New Embedded Image. 

5. Browse to the image and select it. 

6. Save the Plateau.rptlibrary file. 

Adding the Logo to the Report 

In this section, you add the logo from the library to the report. 

 

1. Open the sign-in sheet .rptdesign file. 

2. Delete the logo. 

3. Drag the ACME logo from Resource 
Explorer>PlateauThemes.rptlibrary>Embedded Images to the 
header of the report. If you do not see the image, refresh the resource 

explorer by clicking the Refresh button . 

Creating a Theme in the Library and Adding Styles 

When you add a style to the library, it is accessible to any other report using 
the library like a style in a .css file is available to any .htm file linked to it. 

We recommend that you create a new theme so that if we need to update the 
library, you can merge your theme, as a unit, with the new library. Your 
theme will be independent of system-supplied theme. 
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1. Open Plateau Report Designer, and then open the 
PlateauThemes.rptlibrary file. 

2. In the Outline tab, right-click Themes, and then click New Theme. 

3. Add a new theme called ACMETheme. Themes are containers for styles. 
You create a new theme to keep your styles separate from the delivered 
styles. 

4. Create Styles: 

 If you like many of the styles in the Plateau_stylesheet but you 
want to add additional styles, copy the styles from 
Plateau_stylesheet to ACMETheme. 

 Many organizations have a .css file that defines a pre-existing set 
of styles they want to use. You can import the .css file to the 
theme. 

 You can also create the styles manually. For the purposes of the 
example, you create two styles, one for the dark blue header and 
one for the green header. Right-click the theme to create a new 
style. Develop the style in the properties pane. 

5. Save the PlateauThemes.rptlibrary file. 

Associating the ACMETheme to the Report 

After you create the theme in the library and add styles to it, you need to 
associate the new theme with the report. By doing so, the styles you added 
are available to the report. 

1. If it isn’t already open, open the sign in sheet. 

2. In the outline, click the sign in sheet at the top of the tree to select the 
report properties. 

3. In the Properties pane>Properties>General>Themes, select 
Plateau.ACMETheme. 

4. Save the report. 

If you do not see the styles immediately, it could be that you need to refresh. 
Right-click Sign In Sheet at the top of the Outline tree and then click Refresh 
Library. 

Associating Styles with Report Elements 

After you create the theme, create styles in the theme, and associate the 
theme with the report, you can associate the styles with report elements. 
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1. In the Outline tab, go to the Body node and then open the tree to find 
the element that you want to associate with the new style. In these 
examples, you select the dark blue and the green header rows as shown 
above. 

2. After you select the row, go to Properties 
pane>Properties>General>Style. 

3. Select the new style for the element. 

You can also change the properties without associating the new style to the 
element, but we do not recommend that approach. Using styles creates a 
reusable design. 

Adding Elements to Report Body 

To create space for the added lines at the bottom of the report, you need to 
add a row to the grid and then put another grid inside it. 

 

1. In the Outline of the sign-in sheet, expand the Body node and select the 
grid. Notice that the grid is highlighted in the layout pane. 

2. Right-click Body>Grid, and then click Insert Row. A new row appears at 
the bottom of the grid. If you do not see the row in Layout pane, refresh 
the report. 

3. Open the Body node to the new row you inserted and select the cell 
where you want to insert the lines (as shown in the image above). 

4. Right-click the cell, and then click Insert Element. Select Grid and then 
click OK. 
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5. In the Insert Grid dialog box, make a grid of three columns and two 
rows (six cells). 

6. In each of the six cells: 

 Insert a Text element: Right-click the cell, and then click Insert 
Element. Select Text and then click OK. 

 Add the underscore: In the Edit Text Item, add the line so that it 
appears as above (press the Underscore key _). 

Splitting Cells 

In the as-is report, the User Name heading has under it two columns: 1) for 
the user’s first and last name and 2) for the user’s ID. The following is how 
the table appears in Plateau Report Designer (ignore the TBD syntax, this 
document covers that later). 

 

In the to-be report, you want to remove the User ID and insert a new 
heading, for Email Address. To create the space for the heading, you need to 
split the User Name cell. 

 

1. In the Layout Pane, right-click the cell that contains User Name. 

You need to select the cell, and not the label. This means that you need to 
very carefully click the margin around User Name. 

2. Click Split Cells. 

The result is that you have an additional heading cell to the right of User 
Name. Later in these instructions, you insert text in the heading. 

Repeat these steps for the Supervisor cell. To the right of the Supervisor cell, 
you insert Organization. 

Adding Internationalized Text 

To create a report that can be localized, you use internationalized text, which 
means using labels. You can export the labels from SuccessFactors Learning 
using the label import/export wizard (System Admin>Tools>Label 
Import/Export). Place the resulting .properties file in the workspace. Call 
the .properties file ApplicationResources.properties. 
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1. If you have not done so already, associate the report with the .properties 
resource file. Select the report in the Outline and then go to: Report 
Properties>Resources>Resource File. 

2. Locate the cell to hold the Email Address heading. It is the cell you created 
by splitting in the Splitting Cells section on page 39. 

3. Right-click the cell, point to Insert, and then select Label. Plateau Report 
Designer automatically selects the label you inserted and changes the 
Properties pane to the label. 

4. In the Properties pane, select Localization. 

5. In the Text key box, type label.EmailAddress. This is the key whose value 
is “Email Address” in English. You can also look up the label by clicking 
the ellipsis button (…). 

6. Repeat the steps above for the Organization heading. The key for 
organization is label.Organization. 

Moving and Deleting Report Elements 

The heading of the as-is report is different from the to-be report. For 
example, the scheduled offering ID appears in the header, under which the 
to-be report has the title, facility name, and facility phone number. 

Additionally, you need to remove the segment number, the supervisor ID 
(which has become the column for organization), and the user ID (which has 
become the column for Email Address). 

1. Select the [SCHD_ID] data (appears in Outline>Body as 
Data(SCHD_ID). 

2. Right-click SCHD_ID, and then click Cut. 

3. Right click the cell where schedule ID is to be in the to-be report, right-
click, and click Paste. 

4. Right-click the Schedule Offering ID label, and then click Delete. 

5. Cut the Title label and paste it into the Schedule Offering ID cell you just 
cleared. 

6. Delete the Item label. 

7. Insert labels for Facility and Facility Phone Number as described in the 
Adding Internationalized Text section on page 39. 

8. Delete the TBD cells under Email Address and Organization. 

Changing Data: Getting New Data, Adding Conditional Text 

Working with data is more difficult than changing formatting because you 
must research data and author the SQL statement. 
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Placing Preexisting Data in the Report 

If you edit an existing report, its data sets might already pull the data you 
need. In this section, you place data that the data set already pulls into the 
report. 

In the as-is report, the Instructor column contains the instructors first name, 
last name, and middle initial. The to-be report, however, simplifies matters. It 
includes only the last name of the instructor. 

First, look at the existing cell to learn how operators work. Operators are 
beyond the scope of this document. You can read more about them in the 
Reporting Framework SDK document. 

1. Select the TBD cell under the Instructor label, and then go to the 
Properties pane>User Properties. 

2. Notice the user properties OPERATOR_NAME and 
OPERATOR_COLUMNS. 

3. Go to Properties pane>Advanced and find the properties 
OPERATOR_NAME and OPERATOR_COLUMNS. 

4. In the OPERATOR_COLUMNS property, notice that the value includes 
the first name, last name, and middle initial of the instructor. The report 
is passing these values to SuccessFactors Learning for concatenation. 

After you look at the operator, delete it and add the instructor last name. 

1. Delete the TBD under the Instructor heading. 

2. Select the table and then click Properties pane>Binding. In the Data 
Set box, you can see the data set associated with this table: 
SegmentInfo_Child. 

3. Look for the instructor last name to verify that the data set already selects 
it from the database. It is called: INSTRUCTOR_LNAME. 

4. In the Outline tab, expand Data Sets>SegmentInfo_Child. 

5. Drag INSTRUCTOR_LNAME from the data set to the cell where you 
want it: under Instructor. 

6. Select the table, and then go back to Properties pane>Binding. 

7. Click the Refresh button to refresh the binding. 

Researching and Placing E-Mail Address via Select Statement Addition 

Unlike the instructor last name, the as-is report does not select the user’s e-
mail address. You must modify the SQL statement in the data set to get the 
organization and e-mail address. 

In the case of e-mail address, the SQL change is straightforward. The 
EnrollmentInfo_Child data source is already selected from the 
PA_STUDENT table, where e-mail address is stored in the EMAIL_ADDR 
column. Additionally, the EnrollmentInfo_Child data source is bound to the 
table where you want to place e-mail address and organization. 
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1. Find the table and column that contains the data you want. In this case, 
e-mail address and organization are both stored in PA_STUDENT. 

2. Go to Outline>Data Sets>EnrollmentInfo_Child. Double-click it to 
open it. 

3. In the Query section, modify the SELECT statement of to also gather 
data in the EMAIL_ADDR column. 

4. Go to the Preview Results section to check the query. 

The test depends on a defaulted Scheduled Offering ID in the Parameters 
section. If you do not see any results and you think your SQL is correct, it is 
likely that you need to change the defaulted parameter value. 

5. Click OK to close the data set. You should now see EMAIL_ADDR and 
SUPER under the data set. 

6. Drag EMAIL_ADDR to its correct place in the table. 

7. Refresh the bindings. 

Researching and Placing Organization Description via Join 

Unlike the e-mail address, organization involves more tables than are already 
in the EnrollmentInfo_Child data set. You can select the organization ID 
from the PA_STUDENT table, but you cannot select the organization 
description. And the to-be report should show the description (readable 
name) and not the ID (an alpha numeric code). 

To select the description, you must join the PA_STUDENT table to the 
PA_ORG table. You need to create a join, which will look similar to the 
following. 

This code is provided for illustration purposes only. 

select po.org_desc, rownum ,st.stud_id, st.lname, 

st.fname, st.mi, st.email_addr, 

       

concat(concat(concat(concat(st.lname,','),st.fname),' 

'),st.mi) as user_fn, 

       null as stud_sig, null as stud_sig_date, 

       st.super, sup.LNAME as lname_sup, sup.FNAME as 

fname_sup,sup.MI as mi_sup, 

       

concat(concat(concat(concat(sup.lname,','),sup.fname),

' '),sup.mi) as sup_fn 

from pa_enroll_seat en, pa_student st, pa_student sup, 

pa_enroll_stat es, pa_org po 

where en.schd_id = ? 

  and en.enrl_stat_id = es.enrl_stat_id 

  and es.enrl_stat_typ_id = 'E' 
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  and en.STUD_ID is not null 

  and en.STUD_ID = st.STUD_ID (+) 

  and st.SUPER = sup.STUD_ID (+) 

  and st.org_id = po.org_id (+) 

order by st.lname 

1. Open the EnrollmentInfo_Child data source. 

2. Modify the Query, using a join between pa_student.org_id and 
pa_org.org_id to get pa_org.org_desc. 

3. Test, save, and close the data set. 

4. Drag the ORG_DESC to the table. 

5. Refresh the bindings. 

Apply the same principle to get the data from Schedule_Master for facility 
name and facility phone number. 

Aggregating Data to Create Totals 

The to-be report requests a sum of the users in the user table. The sum, in 
Plateau Report Designer, is called an aggregation. 

 

To insert an aggregation that counts the rows in the table: 

1. Right-click the cell where you want to place the aggregation, point to 
Insert and then click Aggregation. 

2. In the Aggregation Builder dialog box: 

 In the column binding name, type TOTAL_USERS. The 
Column Binding Name appears in the expression builder. You 
will use this later. 

 In the Display Name box, type Total Users. The display name 
appears in the table bindings remind you of the aggregation. 

 In the Function list, select COUNT to count the rows in the 
table. 

 In the Expression list, select ROWNUM. 

3. Click OK. 

Although this example is a simple one, aggregation is a powerful tool for 
dynamic data. Read the report designer help for additional information about 
complex aggregation. 
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Inserting Dynamic Text 

The to-be report requires dynamic text to display text in one of two 
scenarios. 

 

 If the minimum enrollment for the scheduled offering is greater than the 
number of users in the sign-in sheet, then the following text should 
display: “Minimum enrollment not met” 

 If the minimum enrollment for the scheduled offering is equal to or less 
than the amount of users in the sign-in sheet, then the following text 
should display: “Minimum enrollment met.” 

The condition can be expressed: 

If Minimum Enrollment>Users in Course then show “Minimum 
enrollment not met” else “Minimum enrollment met” 

You can build such an expression in the expression builder, but first, you 
must have the operands of the expression. If you aggregated the rows as 
described in the Aggregating Data to Create Totals section on page 43, then 
you have the total number of users, but you still need minimum enrollment. 

For purposes of the example, you get minimum enrollment from the 
Schedule_Master data set even though you want to use minimum enrollment 
in a table bound to EnrollmentInfo_Child. You might do this for very 
practical reasons: the Schedule_Master data set is already going to the 
SCHD_ID table, where the MIN_ENRL column stores the minimum 
enrollment. 

1. Modify Schedule_Master to select MIN_ENRL. 

2. Refresh the bindings for the Schedule Master table. 

3. Go to the data binding of the user table (Table>Properties 
pane>Binding). 

4. Click Add. In the New Data Binding dialog box: 

 In the Column Binding Name box, type MIN_ENRL 

 In the Display Name box, type Min Enrollment 

 In the Data Type list, select Integer 

5. Click the Expression Builder  button. 

6. In the Expression Builder window, select Available Column 
Bindings>Table—Schedule Master, and then double-click MIN_ENRL. 
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Notice that the expression window binds an outside column to the 
current table. 

 

7. Click OK to return to the New Data Binding dialog box, and then click 
OK to save and close the new binding. 

8. Refresh the data binding. 

When you return to the binding, you now have the two operands of the 
expression: the Total Users aggregation and the minimum enrollment data 
binding from schedule master. You can now build your expression. 

The expression builder is a Rhino JavaScript engine, which means it uses 
JavaScript syntax. The expression builder extends the syntax, however, to 
give you easy access to the data in the report, as variables. Until you are 
comfortable with the extended syntax, it might help you to write pseudo-
code. This example uses pseudo-code to explain the expression. 

Start with the expression as written above: 

If Minimum Enrollment>Users in Course then show “Minimum 
enrollment not met” else “Minimum enrollment met” 

Translate the expression to JavaScript syntax pseudo-code (where ME is 
minimum enrollment and UIC is users in course. 
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if (ME>UIC) {" Minimum enrollment not met "} else { " Minimum 
enrollment met" } 

With the pseudo-code, you are ready to add the expression: 

1. Right-click the cell where you want to add the dynamic text, point to 
Insert, and then click Dynamic Text. 

2. Paste the pseudo-code into the expression builder at line 1. Notice the 
syntax highlighting. 

3. Also notice: 

 The buttons at the top, including the Syntax Checker button. We 
recommend you use the syntax checker before you save any 
expression. 

 The operator buttons, which insert common operators into the 
expression. 

 The categories of bindings, parameters, functions, and operators. 
The operators is an extended list of operators. 

4. Delete the placeholder for minimum enrollment (ME) and place the 
cursor in its place. Click Available Column Bidings>Table—
EnrollmentInfo_Child and then double-click MIN_ENRL. 

5. Delete the placeholder for users in course (UIC) and then repeat the 
steps above, selecting the aggregation you created in the Aggregating 
Data to Create Totals section on page 43. If you named it as 
recommended, it is TOTAL_USERS. 

6. When you are finished, the code should appear as follows 
if (row["MIN_ENRL"]>row["TOTAL_USERS"]) {" Minimum 

enrollment not met "} else { " Minimum enrollment met" } 

7. Click OK. 

Formatting Data 

The to-be report improves the formatting of data, particularly the start and 
end date/times of the segment. It also changes the instructor’s full name to 
the instructor’s last name. 

 

Automatic Formatting Based on Data Type 

The BIRT engine formats data based on the type you set in Plateau Report 
Designer. For example, in the as-is report, the data type for the start 
date/time is String because the column uses an operator. The operator puts 
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the date and time in the instructor’s time zone based on the instructor’s 
settings. 

However, in most cases, it is the start date and time for the scheduled 
offering is in the time zone of the location where it is being held. Therefore, 
you can format the date and time in a more readable manner, using the data 
type formatting. 

1. Delete the Text element from the End Date/Time. By deleting the text 
element, you delete the operator. 

2. Drag the End Time data element from the SegmentInfo_Child data set 
to the End Date/Time column. 

3. Double-click the data element you just added and ensure that the Data 
Type is Date Time. The data appears as (for example) Feb 25, 2009 9:00 
AM. 

Using Expression Builder to Format Data 

In the Placing Preexisting Data in the Report section on page 41, you added 
the instructor last name. But if your customer decides that the first name and 
last name of the instructor are important, and that the format should be Last 
Name, First Name, you can build that format in the expression builder. 

1. Double-click the cell containing the instructor last name. 

2. In the Edit Data Binding dialog box, click the Expression Builder  
button. 

3. In the expression builder, type the JavaScript concatenation for the 
elements last name, “, ” and first name. Remember that you can select 
the data first name and last name from the available data sets. It should 
resemble: dataSetRow["INSTRUCTOR_LNAME"] + ", " + 
dataSetRow["INSTRUCTOR_FNAME"] 

4. Click OK to close the Expression Builder window and the Data Binding 
dialog box. 


